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	MOTIVATION
You will configure the enterprise structure and business processes for Financial Accounting.


	After setting up the organization units and process parameters, you will create necessary master data and test the business process.
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You should be familiar with navigation in the SAP system.
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General Notes and Cautions

Warning: When working with other classmates at the same time in the same transactions within “SPRO”, tables will tend to lock up and you will only be able to display them. This is due to the fact that the system does not allow multiple users in the same transaction at the same time. To get passed this message, simply wait until the current user in the transaction is finished and then proceed.

Attributes: At times, certain attributes or fields may not appear to have the name of them in front of the user. To display the full name of the attribute or field, simply click within the field and then press the F1 key. This will bring up not only the title of the field, but it will bring up the full description of it to read.

The ## Symbol: When working with other classmates at the same time, you will be assigned your own unique identifier which is called the ## Symbol or the “Pound Pound” Symbol. This will be your identifier and is ASSIGNED FOR YOUR OWN USE ONLY!!! Please be cautious about other classmates attempting to use your identifier whether it is on purpose or not and if you suspect other classmates using it, inform your professor immediately so that fixes can be made accordingly. For example, if Ashley has an identifier of 09, Ashley’s company code will be US09.

The Search Tool: At times in this document, the instructions will ask you to search for something to put in a field. When it does this, simply click on the field itself and click on the icon to the right of it (it looks like a white square). Clicking on it will bring up another window and you will search from there. You may also search other field by clicking on the downward arrow that may be on the left or right of the field. It will bring up a drop down menu that will have options to choose from and click.

Where do I start? : There are three ways to proceed within the SAP system: Using the “SAP Easy Access” menu, using the “SAP Menu Bar”, and using the “SAP Customizing Implementation Guide” menu. All three of these are explained below:

	1. The SAP Easy Access menu appears when you start a new session.
	2. The SAP Menu Bar also appears when you start a new session at the very top of the screen.
[image: ]
	3. In the SAP Customizing Implementation Guide, there are two ways you may use to get here:

		a. The first is to simply type “SPRO” in the transaction field at the top of the screen.
		b. Proceed through the path to get there. The path consists of the following:

(In the main menu of SAP, click on the black arrows on the left of these names) SAP menu ► Tools ► Customizing ► IMG ► Execute Project (double-click on “Execute Project”)

In the “Customizing: Execute Project” screen, click on the [image: ] icon.

Saving: When the instructions to tell you to save data, always press the “Enter” key to validate. If there are error(s) that occur, they must be corrected before continuing to the next task. You will find errors from a transaction when there are red icons that appear in the message area. Messages that are yellow contain warnings and not errors. At times, these must be fixed in order to move on. However, most of the time, they do not need to be fixed and you can simply enter through them. Green messages are obviously showing that nothing went wrong with the transaction and that you may proceed to the next task.
Set Controlling Area Pop-Up: At times throughout this phase, there will be times when the system asks you enter your controlling area to clarify which controlling area you are configuring for.

If this should happen, in the “Set Controlling Area” pop-up, enter the following information:
	Attribute
	Description
	Data Value

	Controlling Area
	Uniquely identifies a controlling area.
	NA##



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_S_OKAY.gif] (CONTINUE (ENTER)).

This will get you into the next screen where the instructions will then tell you what to do for the task.

Enter Chart of Accounts Pop-Up: At times throughout this phase, there will be times when the system asks you enter your chart of accounts to clarify which chart of accounts you are configuring for.

If this should happen, in the “Enter Chart of Accounts” pop-up, enter the following information:
	Attribute
	Description
	Data Value

	Chart of Accounts
	Key that uniquely identifies a chart of accounts.
	GL##



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_S_OKAY.gif] (CONTINUE (ENTER)).
This will get you into the next screen where the instructions will then tell you what to do for the task.
Differences in Font: Throughout this phase you will see tables with different fonts used in the Data Value column. The normal Times New Roman indicates you enter exactly what is typed out except for the ## Symbol where you would put in your identifier. The italicized Times New Roman font indicates the data is looked up or found.
	Attribute
	Description
	Data Value

	Times New Roman
	Font that tells you to enter what is written.
	Times New Roman

	Times New Roman (Italicized)
	Font that tells you the data that needs to be looked up.
	Times New Roman (Italicized) 
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I.1.1: Define Company Code
Description:  In this step, you will establish a new Company (or in real life, a GBI legal entity) located in the United States.  This Company is represented in SAP by a Company Code.

Your new Company Code is the basis of financial accounting and will eventually include the General Ledger and sub-ledgers.  It will serve as the source for US tax and legal entity reporting.  Your Company Code is assigned to exactly one country (United States), one base currency (US Dollar), and one language (English).

All of your future work (configuration and testing) will be done in your Company Code.

Warning:  See “General Notes and Cautions” about table locks.

	








Navigation: SAP Customizing Implementation Guide ► Enterprise Structure ► Definition ► Financial Accounting ► Edit, Copy, Delete, Check Company Code
In the “Choose Activity” pop-up, double-click on Edit Company Code Data. 
Tasks and Data Entry:
In the “Change View “Company Code”: Overview” screen, click on the [image: C:\Users\Josh\Dropbox\Folder 06\Brandon\Icons\New Entries.PNG] icon. 
In the “New Entries: Details of Added Entries” screen, enter the following information:
	Attribute
	Description
	Data Value

	Company Code
	An organizational unit within financial accounting.
	US##

	Company Name
	Name of Company Code or Company
	## Global Bike Inc.

	City
	City name in an address.
	Dallas

	Country
	The country key contains information which the system uses to check entries such as length of the postal code or bank account number.
	USA 

	Currency
	Currency key for amounts in the system.
	United States Dollar 

	Language
	The language key designates the language in which you display texts, enter texts, or print documents.
	English 



Click on [image: S_B_ADDR] (ADDRESS). 
In the “Edit address: US##” pop-up, enter the following information:
	Attribute
	Description
	Data Value

	Title
	Possible titles are stored in a check table.
	Company

	Name
	Name of an address.
	## Global Bike Inc.

	Search term 1/2
	Short description used for search helps.
	0##

	Street/House Number
	Street name as part of the address.
	5215 N. O’Connor Blvd

	Postal Code
	Postal code as part of the address.
	75039

	City
	City name as part of the address.
	Dallas

	Country
	The country key contains information which the system uses to check entries such as the length of the postal code or bank account number.
	USA 

	Region
	In some countries, the region forms part of the address. The meaning depends on the country.
	Texas 



In the “Street Address” part, click on the [image: S_B_EXPA2]  icon. 
Enter the following information:
	Attribute
	Description
	Data Value

	Tax Jurisdictn
	Specifies the tax jurisdiction. 
	Texas Jurisdiction Code 



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_S_OKAY.gif] (ENTER (CONTINUE)). 
In the “New Entries: Details of Added Entries” screen, click on the [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_SAVE.gif] icon. 
In the “Edit” pop-up, click on the [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_S_OKAY.gif] icon. You will receive a message that says “Data was saved”.


I.1.2: Define Business Area
Description: You will create a Business Area.  Financial statements for your Company Code are structured based on Business Areas.  Large firms - with diversified products - have more than one Business Area, but GBI operates with only one Business Area (## Bikes).

In a later step (Phase III), you will associate this Business Area with GBI’s  Plants and Divisions to allow meaningful financial statements for each Business Area.

Warning:  See “General Notes and Cautions” about table locks.

	





Navigation: SAP Customizing Implementation Guide ► Enterprise Structure ► Definition ► Financial Accounting ► Define Business Area
Tasks and Data Entry: 
In the “Change View “Business areas”: Overview” screen, click on the [image: C:\Users\Josh\Dropbox\Folder 06\Brandon\Icons\New Entries.PNG] icon. 
In the “New Entries: Overview of Added Entries” screen, enter the following information:
	Attribute
	Description
	Data Value

	Business Area
	Key identifying a business area.
	BI##

	Description
	Business area description.
	## Bikes



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_SAVE.gif] (SAVE). You will receive a message that says “Data was saved”. 


I.1.3: Define Empty Chart of Accounts
Description: You will create an empty Chart of Accounts that will eventually be associated with your Company Code.  In later steps you will populate this empty Chart of Accounts with actual General Ledger account numbers, names, and control information.

Warning:  See “General Notes and Cautions” about table locks.

	


Navigation: SAP Customizing Implementation Guide ► Financial Accounting (New) ► General Ledger Accounting (New) ► Master Data ► G/L Accounts ► Preparations ► Edit Chart of Accounts List
Tasks and Data Entry:
You are in the “Change View “List of All Charts of Accounts”: Overview” screen.
Click on [image: C:\Users\Josh\Dropbox\Folder 06\Brandon\Icons\New Entries.PNG] (NEW ENTRIES).
In the “New Entries: Details of Added Entries” screen, enter the following information:
	Attribute
	Description
	Data Value

	Chart of Accts
	Uniquely identifies a chart of accounts.
	GL##

	Description
	Descriptive name for the chart of accounts.
	## GBI COA

	Maint.language
	Language
	English

	Length of G/L account number
	Specifies the length of an account.
	6



Click on  [image: S_F_SAVE] (SAVE). You will receive a message that says “Data was saved”. 


I.1.4: Maintain Controlling Area 
Description: You will create a Controlling Area that will eventually be associated with your Company Code.  A Controlling Area is a Management Accounting entity that rolls up all Cost Accounting data from a Company Code.

Larger firms can roll up many Company Codes into one Controlling Area.  This allows firm management to have one view of Cost Accounting data across multiple legal entities.  

Warning:  See “General Notes and Cautions” about table locks.

	





Navigation: SAP Customizing Implementation Guide ► Enterprise Structure ► Definition ► Controlling ► Maintain Controlling Area 

In the “Choose Activity” pop-up, double-click on Maintain Controlling Area.
Tasks and Data Entry:
In the “Change View “Basic data”: Overview” screen, click on the [image: C:\Users\Josh\Dropbox\Folder 06\Brandon\Icons\New Entries.PNG] icon.
In the “New Entries: Details of Added Entries” screen, enter the following information:
	Attribute
	Description
	Data Value

	Controlling Area
	Uniquely identifies a controlling area.
	NA##

	Name
	Name of the controlling area.
	## GBI North America

	CoCd->CO Area
	Controls assignment of company codes.
	Cross-company-code cost accounting

	Currency Type
	Currency type for a controlling area.
	Company code currency 

	Currency
	Currency key for amounts in system.
	United States Dollar 

	Chart of Accts
	Uniquely identifies a chart of accounts.
	Your Chart of Accounts 

	Fiscal Year Variant
	Used to define the fiscal year.
	Cal. Year, 1 Special Period 


  
Click on [image: S_F_SAVE] (SAVE). You will receive a message that says “Data was saved”. 
Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_ENDT.gif] (EXIT). 
In the pop-up, click on the [image: ] icon. You will receive a message that says “Data was saved”. 


I.1.5: Define Credit Control Area
Description: You will create a Credit Control Area that will eventually be associated with your Company Code.   A Credit Control Area is the organizational unit that manages the firm’s customers’ credit limits.   In later steps you will associate and authorize this Credit Control Area to your Company Code

Larger firms can roll up many Company Codes into one Credit Control Area.  This allows the firm to manage a global customer’s credit across geographic boundaries.

Warning:  See “General Notes and Cautions” about table locks.

	






Navigation: SAP Customizing Implementation Guide ► Enterprise Structure ► Definition ► Financial Accounting ► Define Credit Control Area
Tasks and Data Entry:
In the “Change View “Credit Control Areas”: Details” screen, click on the [image: C:\Users\Josh\Dropbox\Folder 06\Brandon\Icons\New Entries.PNG] icon. 
In the “New Entries: Details of Added Entries” screen, enter the following information:
	Attribute
	Description
	Data Value

	Cred.Contr.Area
	Entity which grants and monitors a credit limit for customers.
	GL## 

	Currency
	Currency Key
	United States Dollar 

	Update
	When the values of open sales orders, deliveries, and billing documents are updated.
	Open order value on time axis, delivery and bill.doct value 

	FY Variant
	A fiscal year variant.
	Cal. Year, 1 Special Period 


  
Click on [image: S_F_SAVE] (SAVE). You will receive a message that says “Data was saved”. 
Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_BACK.gif] (BACK).
In the “Change View “Credit Control Areas”: Overview” screen, enter the following information:
	CCAr
	Description

	Your Credit Control Area 
	## Global Bike Inc.



Click on [image: S_F_SAVE] (SAVE). You will receive a message that says “Data was saved”. 


I.1.6: Define Variants for Open Posting Period 
Description: You will create an empty Variant for Open Posting Periods that will eventually be associated with your Company Code.  This Variant identifies the General Ledger posting periods that can be used during a fiscal year.  

In this step, you create an empty Variant (GL##).  In a later step you will define this Variant to include 13 posting periods per fiscal year.


Warning:  See “General Notes and Cautions” about table locks.

	






Navigation: SAP Customizing Implementation Guide ► Financial Accounting (New) ► Financial Accounting Global Settings (New) ► Ledgers ► Fiscal Year and Posting Periods ► Posting Periods ► Define Variants for Open Posting Periods
Tasks and Data Entry:
You are in the “Change View “Posting Periods: Define Variants”: Overview” screen.
Click on [image: C:\Users\Josh\Dropbox\Folder 06\Brandon\Icons\New Entries.PNG] (NEW ENTRIES).
In the “New Entries: Overview of Added Entries” screen, enter the following information:
	Attribute
	Description
	Data Value

	Variant
	Specifications for a posting period. Each company code refers to exactly one variant. Therefore, as many company codes as you require can use the same variant.
	GL##

	Name
	Posting Period Variant Name
	## GBI Posting Periods


  
Click on [image: S_F_SAVE] (SAVE). You will receive a message that says “Data was saved”.  


I.1.7: Define Field Status Variants
Description: You will copy and rename a Field Status Variant and its related Field Status Groups from Company Code US00.  In a later step, you will associate this Field Status Variant (GL##) with your Company Code.

Your Field Status Groups (Expense Account, Balance Sheet Account, etc.) guide the user experience during General Ledger document entry.  For example, the Field Status Group determines which fields are required, which fields are optional, and which fields are hidden during General Ledger document entry.


Warning:  See “General Notes and Cautions” about table locks.

	








Navigation: SAP Customizing Implementation Guide ► Financial Accounting (New) ► Financial Accounting Global Settings (New) ► Ledgers ► Fields ► Define Field Status Variants 
Tasks and Data Entry:
In the “Change View “Field status variants”: Overview” screen, highlight the “GL00” row. 
Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_COPY.gif] (COPY AS…).
You are in the “Change View “Field status variants”: Overview of Selected Set” screen.
Change the following information:
	FStV
	Field status name

	GL##
	## GBI Field Options



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_OKAY.gif] (ENTER). 
In the “Specify object to be copied” pop-up, click on the [image: ] icon. 
In the “Information” pop-up, click on the [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_S_OKAY.gif] icon. 
In the “Change View “Field status variants”: Overview” screen, highlight the “GL##” row. 
Double-click on Field status groups. 
In the “Change View “Field status groups”: Overview” screen, enter the following information:
	Field status group
	Text

	ZEXP
	## Expense Accounts

	ZGBS
	## General Balance Sheet Accounts

	ZMMA
	## Material Management GR / IR Accounts

	ZRAA
	## Reconciliation Accounts

	ZREV
	## Revenue Accounts



Click on [image: S_F_SAVE] (SAVE). You will receive a message that says “Data was saved”. 


I.1.8: Enter Global Parameters
Description: You will enter global parameters for your Company Code’s financial accounting processes.  This is an important step that:
· associates many of the entities created in previous steps (Chart of Accounts, Credit Control Area, Field Status Variant, Open Posting Period Variant) to your Company Code.
· defines Company Code-wide parameters for ease of use and control (for example:  default date = today’s date and  maximum exchange rate deviation = 10%).
Warning:  See “General Notes and Cautions” about table locks.

	






Navigation: SAP Customizing Implementation Guide ► Financial Accounting (New) ► Financial Accounting Global Settings (New) ► Global Parameters for Company Code ► Enter Global Parameters
Tasks and Data Entry:
In the “Change View “Company Code Global Data”: Overview” screen, double-click on US##.
In the “Change View “Company Code Global Data”: Details” screen, enter the following information:
	Attribute
	Description
	Data Value

	Chart of Accts
	A chart of accounts.
	Your GBI COA 

	Credit Control Area
	Organizational entity which grants and monitors a credit limit for customers.
	Your Global Bike Inc. 

	Fiscal Year Variant
	Define the fiscal year.
	Cal. Year. 1 Special Period 

	Field status variant
	Groups together several field status groups. You assign a field status variant to each company code.
	Your GBI Field Options 

	Pstng period variant
	The specifications for a posting period.
	Your GBI Posting Periods 

	Max. exchange rate deviation
	Exchange rate deviation for postings.
	10%

	Cost of sales accounting actv.
	Specifies the status of cost sales accounting for a company. 
	In preparation 

	Propose fiscal year
	Controls whether the fiscal year is defaulted for display.
	Selected

	Define default value date
	Indicates the current date is used as the default value for the value date.
	Selected

	Financial Assets Mgmt active
	Used to pass on payment information.
	Selected


  
Click on [image: S_F_SAVE] (SAVE). 
If you receive a warning message: Cash discount and tax base control depend on jurisdiction code, then review your checkboxes (only 3 should be checked). 
[image: ]
Press Enter. You will receive a message that says “Data was saved”. 

I.1.9: Assign Company Code to Controlling Area 
Description: You will associate your Company Code to your previously created Controlling Area (NA##).

As noted before, larger firms can roll up many Company Codes into one Controlling Area. This allows management to have one view of Cost Accounting data across multiple legal entities.  In this situation, each Company Code within a given Controlling area can use a different base currency, although they must have the same chart of accounts.   

Warning:  See “General Notes and Cautions” about table locks.

	






Navigation: SAP Customizing Implementation Guide ► Enterprise Structure ► Assignment ► Controlling ► Assign company code to controlling area 
Tasks and Data Entry:
In the “Change View “Basic data”: Overview” screen, highlight the “NA##” row. 
Double-click on Assignment of company code(s). 
You are in the “Change View “Assignment of company code(s)”: Overview” screen.
Click on [image: C:\Users\Josh\Dropbox\Folder 06\Brandon\Icons\New Entries.PNG] (NEW ENTRIES). 
In the “New Entries: Overview of Added Entries” screen, enter the following information:
	Attribute
	Description
	Data Value

	CoCd
	An organizational unit within financial accounting.
	Your Global Bike Inc. 



Click on [image: S_F_SAVE] (SAVE). You will receive a message that says “Data was saved”. 


I.1.10: Assign Controlling Area to Op. Concern
Description: You will associate your Controlling Area to an already existing Operating Concern.   An Operating Concern is a Management Accounting entity that rolls up all profitability data from your Company Code and Controlling Area(s).

Larger firms can roll up many SAP Controlling Areas into one Operating Concern.  This allows management to have one view of profitability across multiple legal entities.

In keeping with the naming conventions used in this exercise, the operating concern should be GL##. However, due to the limitations of the teaching environment, all Controlling Areas will be assigned to the same Operating Concern (GL00).  

Warning:  See “General Notes and Cautions” about table locks.

	









Navigation: SAP Customizing Implementation Guide ► Enterprise Structure ► Assignment ► Controlling ► Assign controlling area to operating concern 
Tasks and Data Entry:
You are in the “Change View “Assignment Operating concern -> CO Area”: Overview” screen.
Enter the following information:
	COAr
	Name
	OpCo

	Your GBI North America 
	## GBI North America
	GL00 (do not make a mistake here)


  
Click on [image: S_F_SAVE] (SAVE). You will receive a message that says “Data was saved”. 


I.1.11: Define Standard Hierarchy
Description: You will create an empty Cost Center Standard Hierarchy within your Controlling Area.  Your Cost Center Standard Hierarchy (NA##) will eventually consist of all Cost Centers within your Company Code for a given time period.  The Standard Hierarchy will represent all costs associated with your legal entity for that time period and will serve as a basis for Management Accounting (Controlling) reporting.

Warning:  See “General Notes and Cautions” about table locks.

	




Navigation: SAP Customizing Implementation Guide ► Controlling ► General Controlling ► Organization ► Maintain Controlling Area
In the “Choose Activity” pop-up, double-click on Maintain Controlling Area. 
Tasks and Data Entry:
In the “Change View “Basic data”: Overview” screen, highlight the “NA##” row. 
Click on [image: S_B_DETL] (DETAILS). 
In the “Change View “Basic data”: Details” screen, enter the following information:
	Attribute
	Description
	Data Value

	CCtr Std. Hierarchy
	Indicated hierarchy of cost center groups in which all cost centers in a controlling area are gathered together.
	NA##


  
Double-click on Activate component/control indicators. 
In the “Check standard hierarchy” pop-up, click on the [image: ] icon. 
In the “Change View “Activate components/control indicators”” screen, click on the [image: C:\Users\Josh\Dropbox\Folder 06\Brandon\Icons\New Entries.PNG] icon. 
In the “New Entries: Details of Added Entries” screen, enter the following information:
	Attribute
	Description
	Data Value

	Fiscal Year
	Period, 12 months as a rule, for which the company is to create its inventory and balance sheet.
	Current Year

	Cost Centers
	Indicator controlling, together with the CO interface, specific settings in Cost Center Accounting.
	Component active

	Order Management
	Together with the CO interface, this indicator controls specific settings for order management.
	Component active

	Commit. Management
	Controls whether commitments are updated.
	Components active



Click on [image: S_F_SAVE] (SAVE). You will receive a message that says “Data was saved”. 


I.1.12: Assign Permitted Credit Control Areas
Description: You will permit your Company Code to a Credit Control Area.  In previous steps you created a Credit Control Area (GL##) and then associated that Credit Control Area (the default Credit Control Area) to your Company Code (see Enter Global Parameters). 

This step associates additional Credit Control Areas to your Company Code.  Thus during the Sales Order process, you can specify any permitted Credit Control Area rather than using the only the default Credit Control Area.

Larger firms can use the Credit Control Area flexibly as a managerial internal control instrument.  GBI, however, associates only one Credit Control Area (GL##) to each Company Code (US##).

Warning:  See “General Notes and Cautions” about table locks.

	









Navigation: SAP Customizing Implementation Guide ► Financial Accounting (New) ► Accounts Receivable and Accounts Payable ► Credit Management ► Credit Control Account ► Assign Permitted Credit Control Areas to Company Code 
Tasks and Data Entry:
You are in the “Change View “Permitted Credit Control Areas per Company Code”: Overview” screen.
Click on [image: C:\Users\Josh\Dropbox\Folder 06\Brandon\Icons\New Entries.PNG] (NEW ENTRIES). 
In the “New Entries: Overview of Added Entries” screen, enter the following information:
	Attribute
	Description
	Data Value

	Company Code
	An organizational unit within financial account.
	Your Global Bike Inc. 

	Cred. Cont. Area
	An organizational entity which grants and monitors a credit limit for customers.
	GL##



Click on [image: S_F_SAVE] (SAVE). You will receive a message that says “Data was saved”. 


I.1.13: Maintain Company Code for Materials
Description: You will maintain your Company Code for Materials Management (inventory) transactions.  Fiscal periods in your Company Code are initialized to allow material –related transactions. 

This step must be completed before material master records are created.  

Warning:  See “General Notes and Cautions” about table locks.

	




Navigation: SAP Customizing Implementation Guide ► Logistics - General ► Material Master ► Basic Settings ► Maintain Company Codes for Materials Management 
Tasks and Data Entry:
You are in the “Change View “Materials Management View on Company Codes”: Overview” screen.
Enter the following information:
	Attribute
	Description
	Data Value

	CoCd
	An organizational unit within financial accounting.
	Your Global Bike Inc. 

	Company Name
	Name of company.
	## Global Bike Inc.

	Year
	A settlement period.
	Current Year

	Pe
	A self-contained part of the current fiscal year.
	Current Month

	Abp
	Indicates that back posting is allowed.
	Selected



Click on [image: S_F_SAVE] (SAVE). You will receive a message that says “Data was saved”. 
Time spent on Part 1: 75 minutes.
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I.2.1: Define Account Group
Description: You will define the Account Groups associated with your Chart of Accounts. Account Groups include: Balance Sheet Accounts, Fixed Asset Accounts, etc.

Each Account Group is
· associated with a contiguous interval of General Ledger account numbers 
· defined by parameters guiding the entry and display of attributes:  which fields are suppressed, required, optional, and displayed. 

Warning:  See “General Notes and Cautions” about table locks.

	






Navigation: SAP Customizing Implementation Guide ► Financial Accounting (New) ► General Ledger Accounting (New) ► Master Data ► G/L Accounts ► Preparations ► Define Account Group 
Tasks and Data Entry:
In the “Change View “G/L Account Groups”: Overview” screen, click on the [image: C:\Users\Josh\Dropbox\Folder 06\Brandon\Icons\New Entries.PNG] icon. 
In the “New Entries: Overview of Added Entries” screen, enter the following information:
	Chrt/Accts
	Acct Group
	Name
	From acct
	To account

	Your GBI COA 
	BS
	## Balance Sheet Accounts
	100000
	399999

	Your GBI COA 
	FA
	## Fixed Assets
	220000
	300000

	Your GBI COA 
	LA
	## Liquid Assets
	100000
	109999

	Your GBI COA 
	MA
	## Material Accounts
	200000
	200999

	Your GBI COA 
	PL
	## Profit & Loss Accounts
	400000
	999999

	Your GBI COA 
	RA
	## Reconciliation Accounts
	110000
	310000



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_OKAY.gif] (ENTER). 
Double-click on ## Balance Sheet Accounts.
In the “Maintain Field Status Group: Overview” screen, double-click on Account control. 
In the “Maintain Field Status Group: Account control” screen, enter the following information:
[image: FI-2_3]
Click on [image: S_F_NXTO] (NEXT GROUP).
In the “Maintain Field Status Group: Account management” screen, enter the following information:
[image: FI-2_4]
Click on [image: S_F_NXTO] (NEXT GROUP). 
In the “Maintain Field Status Group: Document entry” screen, enter the following information:
[image: FI-2_5]
Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_SAVE.gif] (SAVE). You will receive a message that says “Data was saved”. 
Double-click on ## Fixed Assets. 
In the “Maintain Field Status Group: Overview” screen, double-click on Account control. 
In the “Maintain Field Status Group: Account control” screen, enter the following information:
[image: FI-2_9]
Click on [image: S_F_NXTO] (NEXT GROUP). 
In the “Maintain Field Status Group: Account management” screen, enter the following information: 
[image: FI-2_10]
Click on [image: S_F_NXTO] (NEXT GROUP). 
In the “Maintain Field Status Group: Document entry” screen, enter the following information:
[image: FI-2_11]
Click on [image: S_F_NXTO] (NEXT GROUP). 
In the “Maintain Field Status Group: Bank/financials details” screen, enter the following information:
[image: FI-2_12]
Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_SAVE.gif] (SAVE). You will receive a message that says “Data was saved”. 


I.2.2: Copy Document Number Ranges
Description: You will copy number ranges for all Financial Accounting documents from Company Code US00.   As GBI users create vendor credit memos (or any other Financial Accounting document type), each vendor credit memo will have a unique, sequential number from a range defined in this step.

Warning:  See “General Notes and Cautions” about table locks.

	




Navigation: SAP Customizing Implementation Guide ► Financial Accounting (New) ► Financial Accounting Global Settings (New) ► Document ► Document Number Ranges ► Documents in Entry View ► Copy to Company Code 
Tasks and Data Entry:
In the “Document Number Ranges: Copying to Company Code” screen, enter the following information:
	Attribute
	Description
	Data Value

	Source Company code
	The company code is an organizational unit within financial accounting.
	US00

	Target Company code
	The company code is an organizational unit within financial accounting.
	Your Global Bike Inc. 



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_B_EXEC.gif] (EXECUTE). 
In the “Copy document number ranges” pop-up, click on the [image: ] icon. 


I.2.3: Set Up Company for Payment Transactions
Description: You will define the management structure for GBI’s Accounts Payable.  

SAP allows a firm to separate the Company Code that receives a vendor invoice (the Sending Company) from the Company Code that processes the Accounts Payable (the Paying Company).  GBI has made the management decision that each legal entity (Company Code) will be staffed to both receive the vendor invoice and process the Accounts Payable.  Thus sending company = paying company = US##)

Warning:  See “General Notes and Cautions” about table locks.

	






Navigation: SAP Customizing Implementation Guide ► Financial Accounting (New) ► Accounts Receivable and Accounts Payable ► Business Transactions ► Outgoing Payments ► Automatic Outgoing Payments ► Payment Method/Bank Selection for Payment Program ► Set Up All Company Codes for Payment Transactions 
Tasks and Data Entry:
In the “Change View “Company Codes”: Overview” screen, click on the [image: C:\Users\Josh\Dropbox\Folder 06\Brandon\Icons\New Entries.PNG] icon. 
In the “New Entries: Details of Added Entries” screen, enter the following information:
	Attribute
	Description
	Data Value

	Company Code
	The company code is an organizational unit within financial accounting.
	Your Global Bike Inc. 

	Sending company code
	The sending company code is the company code that is known to the business partner.
	Your Global Bike Inc. 

	Paying company code
	In this field you find the company code which processes the payment transactions (possibly for other company codes too).
	Your Global Bike Inc. 



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_SAVE.gif] (SAVE). You will receive a message that says “Data was saved”. 


I.2.4: Maintain Number Ranges for Controlling
Description: In a previous step, you created number ranges for Financial Accounting documents.  In this step you will copy number ranges for all Controlling document types from Controlling Area NA00.  As GBI users create planned cost transactions (or any other Controlling document type), each planned cost transaction will have a unique, sequential number from a range defined in this step.

Warning:  See “General Notes and Cautions” about table locks.

	



Navigation: SAP Customizing Implementation Guide ► Controlling ► General Controlling ► Organization ► Maintain Number Ranges for Controlling Documents 
Tasks and Data Entry:
In the “Number Ranges for CO Documentation” screen, click on the [image: S_F_COPY] icon. 
In the “Copy: COA …” pop-up, enter the following information:
	Attribute
	Description
	Data Value

	From…
	Uniquely identifies a controlling area.
	NA00

	To…
	Uniquely identifies a controlling area.
	Your GBI North America



Click on [image: S_F_COPY] (COPY (ENTER)).
In the “Transport number range intervals” pop-up, click on the [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_S_OKAY.gif] icon.
You will receive a message that says “CO Area copied”. 


I.2.5: Define Tolerance Groups for Employees
Description: You will define the limits and tolerances that serve as internal control mechanisms in Financial Accounting.  For example, you will enter parameters to limit your GBI US employees to:
· entering cash discounts of no more than 5%,
· creating journal entries with a maximum of $500,000.

Warning:  See “General Notes and Cautions” about table locks.

	



Navigation: SAP Customizing Implementation Guide ► Financial Accounting (New) ► Financial Accounting Global Settings (New) ► Document ► Tolerance Groups ► Define Tolerance Groups for Employees  
Tasks and Data Entry:
In the “Change View “FI Tolerance Groups For Users”: Overview” screen, click on the [image: C:\Users\Josh\Dropbox\Folder 06\Brandon\Icons\New Entries.PNG] icon. 
In the “New Entries: Details of Added Entries” screen, enter the following information:
	Attribute
	Description
	Data Value

	Company code
	Organizational unit within accounting.
	Your Global Bike Inc. 

	Amount per document
	Maximum permitted posting amount per document for this user group. It is the total of all debit items credit items.
	500000

	Amount per open item account item
	Maximum posting amount permitted per customer or vendor item.
	100000

	Cash discount per line item
	Maximum cash discount percentage rate which may be assigned by an employee.
	5

	Revenue Amount
	Payment differences to our advantage are allowed up to this amount.
	100

	Revenue Percent
	Differences when settling payments are accepted and posted automatically by the system up to this rate entered. 
	10

	Cash discnt. adj. to Revenue
	Any differences up to this amount are corrected with the cash discount posting as long as the cash discount amount is large enough for adjustment.
	10

	Expense Amount
	Differences to our disadvantage are allowed up to this amount entered.
	100

	Expense Percent
	Differences when settling payments are accepted and posted automatically by the system up to this rate entered. 
	10

	Cash discnt. adj. to Expense
	Any differences up to this amount are corrected with the cash discount posting as long as the cash discount amount is large enough for adjustment.
	10



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_SAVE.gif] (SAVE). You will receive the message “Data was saved”. Time spent on Part 2: 30 mins
Part I.3 – Master Data
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I.3.1: Define Retained Earnings Account
Description: You will create a Retained Earnings account in your new (and current empty) Chart of Accounts.  The balance from each profit and loss account is carried forward at the end of each fiscal year to this Retained Earnings account (Account 330000).

Your Retained Earnings account must be specified within your Chart of Accounts before additional General Ledger accounts are added.  As you add each new profit and loss account, it is automatically linked to the Retained Earnings account for ease of year end closing.   

Warning:  See “General Notes and Cautions” about table locks.

	






Navigation:  SAP Customizing Implementation Guide ► Financial Accounting (New) ► General Ledger Accounting (New) ► Master Data ► G/L Accounts ► Preparations ► Define Retained Earnings Account 
Tasks and Data Entry:
If a dialog box requires your Chart of Accounts. Type GL## and press Enter. 
You are in the “Maintain FI Configuration: Automatic Posting – Accounts” screen
Enter the following information:
	Attribute
	Description
	Data Value

	P&L statmt acct type
	Retained earnings account from each profit and loss account.
	RE

	Account
	General ledger account assigned to retained earnings.
	330000



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_SAVE.gif] (SAVE). You will receive a message that says “330000 not created in chart of accounts”. 
Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_OKAY.gif] (ENTER). You will receive a message that says “Changes have been made”. 


I.3.2: Copy General Ledger Accounts
Description: You will create general ledger accounts within your Chart of Accounts by copying all accounts (100000 to 999999) from Company Code US00.  For each general ledger account, you are copying not only the account number, but also the account name, and the information that controls how an account functions.

Warning:  See “General Notes and Cautions” about table locks.

	



Navigation:  SAP Customizing Implementation Guide ► Financial Accounting (New) ► General Ledger Accounting (New) ► Master Data ► G/L Accounts ► G/L Account Creation and Processing ► Create G/L Accounts with Reference 
Tasks and Data Entry:
In the “Create G/L Accounts with Reference – Overview” screen, enter the following information:
	Attribute
	Description
	Data Value

	Company Code
	Company code to copy accounts to.
	Your Global Bike Inc. 

	Reference company code
	Company code to copy accounts from.
	Global Bike Inc. 



Click on [image: S_F_SAVE] (SAVE). 
In the “Information” pop-up, click on the [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_S_OKAY.gif] icon. 
In the “Create G/L Accounts with Reference – Overview” screen, highlight the “US##” row.
Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_B_DETL.gif] (DETAILS). 
In the “Create G/L accounts with Reference – Accounts” screen, click on the [image: ] icon. 
In the “Using Reference Accounts in Table” pop-up, enter the following information:
	Attribute
	Description
	Data Value

	From G/L acct
	The account you want to use as a reference.
	100000

	To
	The account you want to use as a reference.
	999999



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_S_OKAY.gif] (CONTINUE (ENTER)). 
In the “Create G/L accounts with Reference – Accounts” screen, click on the [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_B_MRKA.gif] icon (select all). 
Click on [image: ] (CREATE G/L ACCOUNTS). 
In the “Table of the G/L accounts in the company code: Display messages” pop-up, click on the [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_S_OKAY.gif] icon.  
In the “Create G/L accounts with Reference – Accounts” screen, click on the [image: S_F_SAVE] icon. 
In the “Information” pop-up, click on the [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_S_OKAY.gif] icon. 

I.3.3: Create Standard Hierarchy
Description: You will populate the Cost Center Standard Hierarchy (NA##) that you created in an earlier step.  The Cost Center Standard Hierarchy is a tree structure that holds all Cost Centers, organizes them into Cost Center Groups, and assigns management responsibilities.

In this step you will create Cost Center Groups and Cost Centers and structure them into the Standard Hierarchy.  You will assign a responsible person to each Cost Center.

Warning:  See “General Notes and Cautions” about table locks.

	





Navigation:  SAP Customizing Implementation Guide ► Controlling ► Cost Center Accounting ► Master Data ► Cost Centers ► Define Standard Hierarchy 
Tasks and Data Entry:
Make sure you are in your Controlling Area (NA##). If not, go to Settings in the menu bar and click “Set Controlling Area” then enter your Controlling Area and press enter.

Warning: You will receive an information message in this exercise “Profit Center Accounting active but not profit center specified”. This is not an error message but a warning message. Press Enter to accept the message and continue with saving.
In the “Standard Hierarchy for Cost Centers Change” screen, enter the following information:
	Attribute
	Description
	Data Value

	Short Description of Group
	Description of Group
	## GBI North America CCtr Std. Hierarchy



Right-click on NA## listed under Standard Hierarchy.
Click on Create Group (Lower Level). 
Enter the following information:
	Attribute
	Description
	Data Value

	Group Name
	Summarizes objects created with master data.
	N10##

	Short Description of Group
	Description of Group
	## Corporate



Press Enter to make your changes take effect.  
Right-click on Corporate.
Click on Create Group (Lower Level).
Enter the following information:
	Attribute
	Description
	Data Value

	Group Name
	Summarizes objects created.
	N11##

	Description of Group
	Description of Group
	## Executive Board



Press Enter to make your changes take effect.
Right-click on Executive Board. 
Click on Create Cost Center. 
Enter the following information:
	Attribute
	Description
	Data Value

	Cost Center
	Key uniquely identifying a cost center.
	NAEX10##

	Name
	General description of the object.
	## John Davis

	Description
	Description
	## NA Executive: John Davis

	Person Responsible
	Person responsible for the given cost center.
	## John Davis

	Cost Center Category
	Indicator used to define a category.
	Administration 



Click on the “Organization” tab. 
Enter the following information:
	Attribute
	Description
	Data Value

	Business Area
	Key identifying a business area.
	Your Bikes 



Click on the “Indicators” tab.  
Enter the following information:
	Attribute
	Description
	Data Value

	Commitment Update
	Key indicating a commitment update.
	Deselected



Press Enter to make your changes take effect.
Right-click on N11##.
Click on Create Cost Center. 
Enter the following information:
	Attribute
	Description
	Data Value

	Cost Center
	Key uniquely identifying a cost center.
	NAEX20##

	Name
	General description of the object.
	## Peter Weiss

	Description
	Description
	## NA Executive: Peter Weiss

	Person Responsible
	Person responsible for the given cost center.
	## Peter Weiss

	Cost Center Category
	Indicator used to define a category.
	Administration 



Click on the “Organization” tab. 
Enter the following information:
	Attribute
	Description
	Data Value

	Business Area
	Key identifying a business area.
	Your Bikes 



Click on the “Indicators” tab.
Enter the following information:
	Attribute
	Description
	Data Value

	Commitment Update
	Key indicating a commitment update.
	Deselected



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_B_PRVI.gif] (CHANGE SEQUENCE: MOVE DOWN). 
Click on [image: S_F_SAVE] (SAVE). You will receive a message that says “Data was saved”.
You will remove an information message. Press Enter to accept the message and continue with saving.
You have just created your Corporate group within the Standard Hierarchy in the steps above.  Appendix A contains data about all of the Cost Centers and Groups used in the Standard Hierarchy at GBI.  Use the data in appendix A to create the rest of the Standard Hierarchy using the steps above as a guide.  



I.3.4: Create Primary Cost Elements
Description: You will create primary Cost Elements.  Primary Cost Elements carry costs from Financial Accounting to Controlling.

Each General Ledger expense account is associated with a primary Cost Element.  Thus each General Ledger expense posting in Financial Accounting is automatically posted in the corresponding primary Cost Element in Controlling.

You will begin by setting up a primary Cost Element to carry all Labor expense from the General Ledger (Account 700000) to Controlling (primary Cost Element 700000).  

Warning:  See “General Notes and Cautions” about table locks.

	





Navigation:  SAP Customizing Implementation Guide ► Controlling ► Cost Element Accounting ► Master Data ► Cost Elements ► Create Cost Elements
In the “Choose Activity” pop-up, double-click on Create Primary Cost Element. 
Tasks and Data Entry:
In the “Create Cost Element: Initial Screen” screen, enter the following information:
	Attribute
	Description
	Data Value

	Cost Element
	Key uniquely identifying a cost element.
	700000

	Valid From
	Date indicating as of when an entry is valid.
	First Day of Current Year



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_OKAY.gif] (ENTER). 
In the “Create Cost Element: Basic Screen” screen, enter the following information:
	Attribute
	Description
	Data Value

	Name
	General description of the object.
	## Labor

	Description
	Description
	## Labor

	CElem
	Number identifying a cost element category used only in the controlling component.
	Primary cost/cost-reducing revenues 



Click on [image: S_F_SAVE] (SAVE). You will receive a message that says “Cost element has been created”.
You have just created your Labor primary cost element in the steps above.  Appendix B contains data about all of the primary cost elements in GBI.  Use the data in appendix B to create the remaining primary cost elements.  
For Cost Elements 650000 and 650100, “Cost Center” can be found under the “Default Acct Assgnmt” tab.  


I.3.5: Create Secondary Cost Elements
Description: You will create secondary Cost Elements.  Secondary cost elements are defined only in Controlling and are different than Primary Cost Elements in that they do not correspond to General Ledger accounts.  Secondary Cost elements carry costs within the Controlling module, and are used for allocations and settlements between - and among - Cost Centers.   

You will begin by setting up a secondary Cost Element (800000) to allocate Labor expense among different departments within your Company Code.

Warning:  See “General Notes and Cautions” about table locks.

	




Navigation:  SAP Customizing Implementation Guide ► Controlling ► Cost Element Accounting ► Master Data ► Cost Elements ► Create Cost Elements
In the “Choose Activity” pop-up, double-click on Create Secondary Cost Element. 
Tasks and Data Entry:
In the “Create Cost Element: Initial Screen” screen, enter the following information:
	Attribute
	Description
	Data Value

	Cost Element
	Key uniquely identifying a cost element.
	800000

	Valid From
	Date indicating as of when an entry is valid.
	First Day of Current Year


	
Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_OKAY.gif] (ENTER). 
In the “Create Cost Element: Basic Screen” screen, enter the following information:
	Attribute
	Description
	Data Value

	Name
	General description of the object.
	## Labor Allocation

	Description
	Description
	## Labor Allocation

	CElem
	Number identifying a cost element category used only in the controlling component.
	Internal activity allocation 



Click on [image: S_F_SAVE] (SAVE). You will receive a message that says “Cost element has been created”.
You have just created your Labor Allocation secondary cost element in the steps above.  Appendix C contains data about all of the secondary cost elements in GBI.  Use the data in appendix C to create the remaining secondary cost elements.  


I.3.6: Create Cost Element Groups
Description: You will create Cost Element Groups.   A Cost Element Group is simply a collection of Cost Elements with similar characteristics.  They are used to track and control costs more efficiently.  

You will create a Cost Element Group that consolidates all Cost Elements (NA10##), another Cost Element Group that consolidates all primary Cost Elements (NAPRIM10##), and a third Cost Element Group that consolidates all secondary Cost Elements (NASECO10##).

Warning:  See “General Notes and Cautions” about table locks.

	





Navigation:  SAP Customizing Implementation Guide ► Controlling ► Cost Element Accounting ► Master Data ► Cost Elements ► Create Cost Element Groups

In the “Choose Activity” pop-up, double-click on Create Cost Element Group. 
Tasks and Data Entry:
In the “Create Cost element group: Initial Screen” screen, enter the following information:
	Attribute
	Description
	Data Value

	Cost element group
	Summarize objects created with master data maintenance.
	NA10##



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_OKAY.gif] (ENTER). 
In the “Create Cost element group: Structure” screen, enter the following information:
	Attribute
	Description
	Data Value

	Short description of a set
	Description
	## NA Cost Element Total



Click on [image: ] (INSERT COST ELEMENT GROUP ON LOWER LEVEL). 
Enter the following information:
	Attribute
	Description
	Data Value

	Set Name
	Used for organizing hierarchies.
	NASECO10##

	Short description of a set
	Description of the Group
	## NA Secondary Cost Element Total



Click on [image: ] (INSERT COST ELEMENT).
Enter the following information:
	Attribute
	Description
	Data Value

	From Value
	The lower limit of the interval in the set line.
	Your Labor Allocation 

	To value
	In conjunction with the “from” value.
	899999



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_OKAY.gif] (ENTER). 
Click on NA10##.
 Click on [image: ] (INSERT COST ELEMENT GROUP ON LOWER LEVEL).
Enter the following information:
	Attribute
	Description
	Data Value

	Set Name
	Used for organizing hierarchies.
	NAPRIM10##

	Short description of a set
	Description of the Group
	## NA Primary Cost Element Total



Click on [image: ] (INSERT COST ELEMENT).
Enter the following information:
	Attribute
	Description
	Data Value

	From Value
	This field contains the lower limit of the interval in the set line.
	Your Labor

	To value
	In conjunction with the “from” value.
	799999



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_OKAY.gif] (ENTER).
Click on [image: S_F_SAVE] (SAVE). You will receive a message that says “The changes have been saved”.


I.3.7: Open Periods for Variant
Description: In a previous step, you created an empty Variant for Open Posting Periods.  In this step, you will specify which fiscal periods are open for posting within your variant.  You will create 12 standard periods and one special period (13) for each fiscal year.  The special period is usually used for audit adjustments.

Warning:  See “General Notes and Cautions” about table locks.

	


Navigation:  SAP Customizing Implementation Guide ► Financial Accounting (New) ► Financial Accounting Global Settings (New) ► Ledgers ► Fiscal Year and Posting Periods ► Posting Periods ► Open and Close Posting Periods 
Tasks and Data Entry:
You are in the “Change View “Posting Periods: Specify Time Intervals”: Overview” screen.
Click on [image: C:\Users\Josh\Dropbox\Folder 06\Brandon\Icons\New Entries.PNG] (NEW ENTRIES). 
In the “New Entries: Overview of Added Entries” screen, enter the following information:
	Attribute
	Description
	Data Value 

	Var.
	Describes the specification for a posting period.
	Your Variant 

	A
	Account types the variant is valid for.
	Valid for all account types 

	From per. 1
	First interval, together with the specified year, produces the beginning of the allowed posting period interval.
	1

	Year
	Produces the beginning of the allowed period interval.
	Current Year

	To period
	Produces the end of the allowed posting period interval.
	12

	Year
	Produces the end of the allowed posting period interval.
	9999

	From per. 2
	Second interval, together with the specified year, produces the beginning of the allowed posting period interval.
	13

	Year
	Produces the beginning of the allowed period interval.
	Current Year

	To period
	Produces the end of the allowed posting period interval.
	13

	Year
	Produces the end of the allowed posting period interval.
	9999



Click on [image: S_F_SAVE] (SAVE). You will receive a message that says “Data was saved”. 


I.3.8: Close Period
Description: You will close the previous posting period. During the period end closing process, specific Financial Accounting postings are created.




Navigation:  SAP menu ► Logistics ► Materials Management ► Material Master ► Other ► Close Period 
Tasks and Data Entry:
In the “Close Period for Material Master Records” screen, enter the following information:
	Attribute
	Description
	Data Value

	From company code
	An organizational unit with financial accounting.
	Your Global Bike Inc. 

	To company code
	An organizational unit with financial accounting.
	Your Global Bike Inc. 

	Period
	Self-contained part of the specified fiscal year.
	Current Month

	Fiscal year
	Defines a settlement period.
	Current Year



Click on [image: S_B_EXEC] (EXECUTE).
This happens only if the month rolls over during the configuration. Otherwise, this step is not needed. If this step is successful, you will be brought to a screen that says, “Period closing complete; log issued”.
 
Time spent on Part 1: 90 minutes.

Part I.4 – Process Execution

Table of Contents
I.4.1: Review Accounts	39
I.4.2: Display Balances I	40
I.4.3: Enter General Ledger Account Postings	41
I.4.4: Display Balances II	42


I.4.1: Review Accounts
Description: Testing of Financial Accounting is organized into four steps.
· Review account configuration
· Display General Ledger balances
· Create and post General Ledger transactions
· Verify posting by displaying General Ledger balances.
In this step, you will verify that your Supplies Expense account is correctly configured within your Company Code.










Navigation: SAP menu ► Accounting ► Financial Accounting ► General Ledger ► Master Records ► G/L Accounts ► Individual Processing ► Centrally
Tasks and Data Entry:
In the “Edit G/L Account Centrally” screen, enter the following information:
	Attribute
	Description
	Data Value

	G/L Account
	Identifies the general ledger account in a chart of accounts.
	Your Bank Account 

	Company Code
	An organizational unit within financial accounting.
	Your Global Bike Inc. 



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_OKAY.gif] (ENTER). 
Review the account and verify that the information is correct with your configuration.
Enter the following information:
	Attribute
	Description
	Data Value

	G/L Account
	Identifies the general ledger account in a chart of accounts.
	Your Supplies Expense 



Click on [image: C:\Users\Mike\Dropbox\Folder 05\SAP Icons\S_F_OKAY.gif] (ENTER).  
Review the account and verify that the information is correct with your configuration.


I.4.2: Display Balances I
Description: You will display your General Ledger account balances:  all credit and debit balances for each posting period within this fiscal year.

Note that after you click on the Execute icon, you will receive a pop-up that says “No data found for fiscal year”. This simply means that the total debit balance and the total credit balance are both zero because no General Ledger transactions have occurred yet in your Company Code.








Navigation:  SAP menu ► Accounting ► Financial Accounting ► General Ledger ► Account ► Display Balances (New) 
Tasks and Data Entry:
In the “G/L Account Balance Display” screen, enter the following information:
	Attribute
	Description
	Data Value

	Account Number
	Account Number
	Your Bank Account 

	Fiscal Year
	Period a company creates its inventory and balance sheets.
	Current Year



Click on [image: S_B_EXEC] (EXECUTE). 
Review the account and verify that the Total Debit and the Total Credit balance are 0.00.
If you receive a pop-up that does not let you into the screen, assume the account balance is $0.00.


I.4.3: Enter General Ledger Account Postings 
Description: You will create two financial transactions and post them to your General Ledger:
· Issue common stock (debit bank account, credit Common Stock)
· Purchase supplies (debit supplies expense, credit bank account)





Navigation:  SAP menu ► Accounting ► Financial Accounting ► General Ledger ► Document Entry ► Enter G/L Account Document 
Tasks and Data Entry:
In the “Enter G/L Account Document” screen, enter the following information in the Header:
	Attribute
	Description
	Data Value

	Document Date
	The date in which the original document was issued.
	Current Date



Enter the following information in the Line Items:
	Attribute
	Description
	Data Value

	G/L Acct
	General ledger account.
	Your Bank Account 

	D/C
	The side of account the transaction figures are updated.
	Debit

	Amount in doc.curr
	Line item amount in document.
	60000

	
	
	

	G/L Acct
	General ledger account.
	Your Common Stock 

	D/C
	The side of account the transaction figures are updated.
	Credit

	Amount in doc.curr
	Line item amount in document.
	60000



Click on [image: S_F_SAVE] (SAVE). You will receive a message that says “Document was posted”.
In the “Enter G/L Account Document” screen, enter the following information in the Header:
	Attribute
	Description
	Data Value

	Document Date
	The date in which the original document was issued.
	Current Date



Enter the following information in the Line Items:
	Attribute
	Description
	Data Value

	G/L Acct
	General ledger account.
	Your Supplies Expense 

	D/C
	Side of the account the figures are updated.
	Debit

	Amount in doc.curr
	Line item amount in document.
	500

	Cost center
	Key identifying a cost center.
	Your Admin Costs  

	
	
	

	G/L Acct
	General ledger account.
	Your Bank Account 

	D/C
	Side of the account the figures are updated.
	Credit

	Amount in doc.curr
	Line item amount in document.
	500



Click on [image: S_F_SAVE] (SAVE). You will receive a message that says “Document was posted”. 
[bookmark: _GoBack]

I.4.4: Display Balances II
Description: You will display and verify your General Ledger account balances after having completed the two journal entries in the previous step.



Navigation:  SAP menu ► Accounting ► Financial Accounting ► General Ledger ► Account ► Display Balances (New) 
Tasks and Data Entry:
In the “G/L Account Balance Display” screen, enter the following information:
	Attribute
	Description
	Data Value

	Account Number
	Account Number
	Your Bank Account 

	Fiscal Year
	Period a company creates its inventory and balance sheets.
	Current Year



Click on [image: S_B_EXEC] (EXECUTE). 
Review the account and verify that the cumulative balance is $59,500.00.
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[l General Notes and Cautions

‘Warning: When working with otker classmates atthe same time in the same transactions within
“SPRO",tables willtend to lock up and you will only be able to display thers. This s due to the fact that
the system does not allow multple users in the same transaction at the same time. To get passed this
‘message, simply wait uni the current use in the transaction i fnished and then proceed.

Atributes: At times, certain atributes or felds may not appear t have the name of them in front of the
user. To display the full name of the attribute or field, sumply click within the field and then press the F1
ey, This will bing up it only the tile of the field but it will bring up the full description of it to read.

‘The ## Symbol: When working with ofher classmates atthe same time, you will be assigned your own
‘unique identifier which s caled the # Symbol orthe “Pound Pound Symbol. This will be your
identifir and is ASSIGNED FOR YOUR OWN USE ONLY ! Please be cautious about other classmates
aftempting o use your identifier whether it is on purpose or not and if you suspect other classmates using.
i, inform your professor immediately so hat fxes can be made accordingly. For example, f Askley has
2n identfier of 09, Askley's company code will be US09.

‘The Search Tool: At fimes in this document,the instructions will ask you to search for something to put
ina field. When it does tis,simply click: on the feld itelf and click on the icon to the right of it ooks
ke 2 white square). Clicking on it will bring up another window and you will search from there. You
may also search other field by clcking on the downward arrow that may be on the le or right of the
Seld. Tt will bring up a drop dovwn mem hat vl have options to choose from and click.

‘Where do I start? : There are three ways to proceed within the SAP system: Using the “SAP Easy
Access” meny, using the “SAP Menu Bar”, and using the “SAP Customizing Implementation Guide™
‘menu. All three of these are explained below:

1. The SAP Easy Access menu appears when you start a new session.
2. The SAP Memu Bar also appears when you start a new session at the very top of the screen.
3.In the SAP Customizing Tmplementation Guide, there are two ways you may use to get here:

2 The firts to simply type “SPRO in the ransaction field atthe top of the screen.
b. Proceed through the path to get there. The path consits of the following:

(I the main menu of SAP, click on the black arrows on the left of these names) SAP menu &
Tools ¥ Customizing ¥ MG »- Execute Project (double-click on “Execute Project”)

In the “Customizing: Execute Project” screen, clck on the “SAP Reference IMG” icon.

Saving: When the instructons to tell you to save data, always pressthe “Eater” ey to validate, Ifthere
are emor(s) that occur, they must be corrected before continuing tothe next task. ¥ou will fnd ertors
from a ransaction whe there are red icoms that appear inthe message area. Messages that are yellow
contain wamings and not erors. At times, these mustbe fixed in order to move on. However, most of the
ime, they do not need to be fixed and you can simply enter through them. Green messages are obviously
showing that nothing went wrong with the ransaction and that you may proceed to the ext task.

Sign in
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